VOLUME 56 NO. 05

Many birding venues are within easy reach

Spring Birding Time Is Finally Here
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Birding Spots continued:

Finley WR Day tr’lp

Drive time - 40 min. - Ten mi. N. of
Monroe on Hwy, 99 W. Turn W. on Bruce
Rd. Two miles to small mitigation pond.

https://www.fws.gov/refuge/

william 1 finley/

Ridgefield WR Day trip.

Drive time - 3 hrs, - 10 miles N. of
Columbia Riv. on I-5. Take Ridgefield
exit West. Refuge is 1 mi. S. of town.
Two mi. loop varying eco. i{ystems

https://ridgefieldfriends.org/

continues on next page
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Birding Spots continued:
Cabin Lake CG Day trig.
to

Drive time - 3 hrs. - East on 5
61 to 97 to 31. Eight mi. past Ft. Rock to
unimproved campground - So. of split rail
fence - two small rickety blinds - water spot
for small birds - chip monks. http://trav-
eloregon.com/see-do/recreation/camping-
recreation/hiking/cabin-lake-campground/

Klamath WR Overnight.

Drive time - 4 hrs. - East on Hwy
58 -S.0n 97. Ten mi. S. of Klamath Falls to
State Line Rd. Ten mi. loop in maf'or flyway
- eagles - pelicans - water birds. https://
www.fws.gov/refuge/klamath marsh/

Summer Lake WR Overnight.

Drive time - 4.5 hrs. - East on 58
to 61 to 97 to 31. Five mi. loop - major
flyway - min. lodging. http://www.dfw.
state.or.us/resources/visitors/summer
lake wildlife area.asp

Malhuer WR  Overnight.

Drive time - 6 hrs. - East on 126 to
20 to Burns. So.- 205 - Ref. Hqts. Major
flyway - Ten mi. loop - Best OR hot spot.
https://www.fws.gov/refuge/malheur/ E

Remaining
EPS Field Trips

* May 13 - 15

OR Coast - Shore Acres & area
-A. Adam

* May 16

Ridgefield WR - Cedar Creek
Grist Mill - R. Seguin / B. Bittle

* May 22-25 - Tetons/Yellow-
stone Nat. Pks.- G. Smith / B. Bittle

* June 10-11

Duchess Horse Sanctuary (12
members needed) - 4. Adam

e June 17

Eclipse Rehearsal - T Smith

e July 7-11

DDD Photo Game Farm, Ka-
lispell, MT - G. Smith

e July 15

Eclipse rehearsal - 7. Smith

* August 12

- Sweet Creek Falls - 4. Adam

* August 21

Solar Eclipse - Everyone for
themselves - Good luck!

New 2018 Digital
Rules Suggested

These are the changes to the Com-
petition Rules suggested during the past
Board Meeting (the page numbers refer
to the document currently on the web-
site). The suggested changes are in red.

Page 6:

Replace: “A digital copy of all
entered print images, using club file
name convention, must be uploaded to
Score27 for scoring purposes”

With: “A digital copy of all en-
tered print images, using club file name
convention, must be uploaded to the
scoring program (Photo Contest Pro cur-
rently) for scoring purposes”

Page 7:

Add at the end of the scoring
guide: “Judges can fine-tune the scores
by half points, e.g. 5.5, 6.5. This does
not apply to 9 points which is the perfect
score.”

Page 9:

Change Awards to read:

“All images scoring over 18 points
will be acknowledged during the com-
petition. The four highest scores will
be awarded First Place, Second Place,
Third Place and Honorable Mention.”

Page 10:

Replace “Three guest judges
(non-EPS members) are selected by the
competition committee chair.”

With: “Three guest judges (non-
EPS members) are selected by the
critiquing committee chair.”

Hernando Convers

EPS Competition Chair

tion with Ed Night - 4. Adam
* October 21
Japanese Gardens Portland -
A. Adam
* November 18
The Dalles Exploration w/
Maryhill Moon Shoot / Alford Desert

Teton -
Field Trip Update

Twenty-Two EPSers and invited
guests now have plans in place to be
in the parks from the 22nd to the 25th
of May which is prime time for spring
flowers and snow covered mountains.

Motel and RV reservations are
still available in downtown Jackson
and a tentative travel itinerary to and
from has been suggested. However,
getting there and coming back are
entirely open ended for everyone.

This field trip is going to be the
best attended long-distance EPS Field
Trip in the history of the club. Anyone
still interested should contact Graham
Smith (541.683.8899) or Bruce Bittle
(541.343.2386) for complete details.

Bruce Bittle

EPS Officers

President —
Dave Horton
Vice President —
Stephen Franzen
Secretary —
Tom Bruno
Treasurer —
Kevin Reilly
Webmaster —
Mike Van De Walker
Challenge Night Chair —
David Putzier
Education Night Co Chairs —
Tom Bruno, Jon Parker,
Susan Starr
Competition Chair —
Hernando Convers

Back up — Mark Gotchall
Photo Forum Chair —
Kurt Pratt
Critiquing Chair —
Bob Petit
Board Members at Large —
Jeff Green, Graham Smith,

* September 16 - (Alt. Deerhorn property) A. Adam David Winther
Masonic Cemetery - In conjunc- * December - TBA
3 The Bellows May 2017
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Was “NanoCar Race” Poster, Faux News?
If it looked like a NASCAR April fool spoof last month, YOU were fooled!

Unknown:

If winners received
nano trophies
invisible to the

naked eye.

SW|ss
Wlnn rs

Yes, fooling was easy unless
you stumbled upon this event on
YouTube while it was in the process
of being created. Before race day,
April 28, finally arrived it had been
postponed several times because
drivers needed more practice.

This first International Nano-
Car Endurance Race, after startup
troubles, was won by Team Swiss
driving on a gold track in a high-tech
nano lab in Tolouse, France.

Racing single molecule cars
built with 100 atoms or less for the
first time, proved much harder even
on race day.

Ten minutes into the race it had
to be stopped and restarted because
the Scanning Tunneling Microscope
(STM) lost the track. Molecule cars
are 30,000 times smaller than the
thickness of a human hair and easily
wrecked. Just ask Team Japan.

Stats:

* Fastest car - 35 nm/hr - (USA*)

* Avg. speed all cars - 10 nm/hr

* Track temp - minus 268°

* Cars are scooted along when the STM
needle above the cars, zaps them with an
exceedingly small amount of electricity
without touching it.

* Cars dlsmtegrate if touched by the
needle. Yup, ask Team Japan

* At 10 nm/hr. moving an entire mile
would take about 17 million years.

* Team USA didn’t pass the Tech Inspection
because they refused to disclose the formula for their
g molecule car.

e * Also disqualified, because they demanded a
FOR MU LA e i silver track rather than gold Rules have reasons?
Conndentlal ’ * Probably cheated in other undisclosed
ways similar to Smokey Yunich’s myriad ~ _
of ways in the early days of NASCAR. I@
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Fastest Camera: Makes Light Almost — Stand Still

orget high-speed cameras

capturing 100,000 images : N_ [_[ M D
, per second. A research . LU NIVERSITY
group at Lund University in Sweden
has developed a camera that can cap- ' ; 4"’!

ture images at a rate equivalent to five
trillion images per second, or events
as short as 0.2 trillionths of a second.
This is faster than has previously been

possible. §

The new super-fast camera will é
therefore be able to capture incredibly 3
rapid processes in chemistry, physics, -é
biology and biomedicine, that so far &
have not been caught on film. The new camera was developed for filming chemistry

To illustrate the technology, the and physics occurring at extreme speeds.
researchers have successfully filmed
how light -- a collection of photons the Many of these processes happen more fuel-efficient. Combustion is
thickness of a piece of paper -- travels  in a femtosecond, which is unbeliev- controlled by a number of ultra-fast
a distance that takes only a picosec- ably fast -- the number of femtosec- processes at the molecular level,
ond, but the camera slows it down a onds in one second is significantly which can now be seen for the first
trillion times. larger than the number of secondsina  time.

In short, the method involves person’s life-time. Researchers using this tech-

ATTENTION EPS MEMBERS
We Have An All Members Print Show At The Courthouse In June

Members displaying at this venue before may submit two images
New members are welcome to submit three images
Club standard black frames & double white mats are required

exposing what you are filming (for “This does not apply to all pro- nology called FRAME (Frequency
example a chemical reaction) to light cesses in nature, but quite a few, We Recognition Algorithm for Multiple
in the form of laser flashes where each ~ are now able to film such extremely Exposures) will now be able to study
light pulse is given a unique code. The  short processes,” says researcher the chemistry of plasma discharges,
object reflects the light flashes which Elias Kristensson. “In the long term, the lifetime of quantum states in com-
merge into the single photograph. They  the technology can also be used by bustion environments and in biologi-
are subsequently separated using an industry and others.” cal tissue, as well as how chemical
encryption key. Most days, Elias Kristensson reactions are initiated.

The camera is initially intended and assistant Andreas Ehn conduct A German company has already
to be used by researchers who [need] to  research on combustion -- an area developed a prototype of the tech-
gain better insight into many extremely ~ which is known to be difficult and nology, which means that within an
rapid processes occurring in nature. For  complicated to study. The ultimate estimated two years more people will
example, explosions, plasma flashes, purpose of this basic research is to be able to use it.
turbulent combustion, brain activity in ~ make next-generation car engines, Science Daily, April 28, 2017

. . . . . Lund University I@
animals or chemical reactions. gas turbines and boilers cleaner and
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4Cs Convention, October 6-7, Ashland, OR

SAVE THE DATE!
October 5-8, 2017

Columbia Council of Camera Clubs
Photography Convention

in beautiful Ashland, Oregon
Keynote Speaker & Workshops by George Lepp

Workshops by:

Dayvid Vanderlip (Lightroom & Photoshop Instruction)
Gordon Battaile (Surreal Photography)
Michael Anderson (HDR)

Deb Harder (Portrait Photography & Travel)
David Lorenz Winston (Ashland Alleys)

“Photo Joseph” Joseph Linaschke (Mirrorless Cameras)
Lewis Anderson (Textures in Photoshop)

Glen Bledsoe & Chris Taylor (Infrared Photography & Compositing)
Kat Sloma, (Cell Phone Photography)
Christopher Briscoe (Drone photography)

Field Trips and more!

Public Invited!
Convention will be held at Southern Oregon University’s Stevenson Union
www.columbiacameraclubs.org

Email: sopacameraclub@gmail.com

7 The Bellows May 2017
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0 & A With Tim Grey

[Some] images
include a copyright
symbol. How do you
get that copyright
symbol to show up?

*

The copyright
4 symbol appears au-
tomatically in front
of the filename for an
image in Photoshop if the Copyright
Status in metadata is set to “Copy-
righted” rather than “Unknown” or
“Public Domain”.

Note that the Copyright Sta-
tus field within Adobe applications
(including Photoshop, Bridge, and
Lightroom) is Adobe-specific and
other software tools may not support
this metadata field.

If you’re using Adobe software
to manage your photos and you apply
“Copyrighted” to your photos, this
might not prevent someone from using
[it] without permission, but it couldn’t
hurt to have this in the Metadata.

In Lightroom, choose Default
from the header of the Metadata sec-
tion of the Library module. In Adobe
Bridge or Photoshop choose File >
File Info from the menu.

This field is specific to Adobe
software products and worth [apply-
ing] to all of your photos. Also, any
image is technically “copyrighted” the

moment you capture the photo.

[Even officially registered with
the Library of Congress your photo
can still be stolen. However, if an il-
legal use is worth pursuing you’ll have
an airtight case, unless the image has
been altered in any way by the thief.
Then the outcome becomes a huge
expensive can of courtroom worms.

So, tread carefully. Ed]

‘ I’ve been look-
ing for a software
program that will

‘ allow me to make a
time-lapse video of
300-400 images. Any suggestions?

My preference
‘ is to use video editing
software to assemble
time-lapse videos.
This provides the additional benefit of
being able to apply adjustments and
effects to your final video. I use Adobe
Premiere Pro for this purpose, but you
could also employ Adobe Premiere El-
ements if you prefer a more basic tool.
With video editing software you
can include still images, and specify
the duration for each still. For ex-
ample, if you specify that each still
should be displayed for one frame,
then for every thirty photos you’ve
captured you’ll end up with one sec-
ond of time-lapse video.

In Premiere Elements you can
specify a default number of frames for
each still image within the Preferences
dialog. You can then import all of your
still photos into your project, select
them all, and add them to the timeline.

Another approach you could use
in Premiere Elements would be to use
the “Time Stretch” feature. With this
approach you don’t need to specify
a still image duration before you get
started, letting the software fine-tune
that setting by applying the “Time
Stretch.”

You can find Premiere Elements
(download version for Macintosh)
here: http://amzn.to/2ovHnIH

( Articles reprinted with permission )

What is the best
way to remove yellow
from photos when the
photographer did not
use a flash?

L
L

Simply shifting
‘ the Temperature slider
toward blue (away from
yellow) is a good solu-
tion. Even if the photo was not a RAW
capture, you [can] use the Camera Raw
Filter in Photoshop, (and Lightroom)
on a JPEG capture.

If the color cast is too strong for
[slider] adjustment, I [use] a [custom]
technique in Photoshop. Start by drag-
ging the thumbnail for the Background
layer to the “Create a New Layer” but-
ton (blank paper icon) at the bottom.

Next, choose Filter > Blur >
Average from the menu. This processes
the Copy layer to contain only pixels
of the color of your strong color cast.
[Then] choose Image > Adjustments >
Invert to reverse the color [yellow] to
the opposite [blue].

Then,Click the popup at the top-
left of the panel (change default Nor-
mal to Color) [This] sets a blend mode
[that] alters only the color (not the tone
or texture) of the underlying image.

Finally, reduce the strength of the
new color [with] Opacity of the Copy
layer. [Use] the control at the top-right
of Layers panel. Start at a 50% and
fine-tune from there. Tweak overall
saturation and contrast to compensate
for other issues in the image.

[Then in Layers, Merge Layers
and Save As with a new Title for this
image. This preserves both the original
and the newly tweaked image as sepa-
rate files. Ed]

8
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What To Know l Where To Go '

NEW MEETING
LOCATION

Northwood Christian Church
2425 Harvest Lane
Corner of Harvest Lane
& Hayden Br. Road, Springfield)

New Meeting Night
THURSDAY

May 2017
4 Challenge Night - Theme, Architecture
11 Ed. Night, TBA
18 Print & Digital Competition night
25 Photo Forum Night, Q & A, Demos

June 2017
1 Challenge Night - Theme TBA May 4
8 Ed.Night, TBA
15 Print & Digital Competition night
22 Photo Forum Night, Q & A, Demo
29 EPS Board Meeting All welcome

No EPS
Meetings in
July & August
Happy Summer Shooting

September 2017
7 Challenge Night - Theme TBA June 1
14 Ed.Night, TBA
21 Print & Digital Competition night
28 Photo Forum Night, Q & A, Demo

* David Becker —
Had a photo entitled, “Lone
Rider, ’selected for the Artwork NW 2017
Show at the Umpqua Valley Art Asso.,
1624 W. Harvard, in Roseburg, and can
be seen from May 5Sth until June 30th.
David is one of 46 artists whose
work was selected for the show and his
image is one of 500 submitted. A recep-
tion is scheduled for 5-7pm on the 5th

Attention EPS Members

* At the Courthouse

The Emerald Photographic
Society will have a show in the Har-
ris Hall Lobby at the Lane County
Courthouse, 125 E 8th Ave. in
Eugene for the month of June. The
lobby is open 8-5 weekdays. Show
goes up the 1st, comes down the 30th,

Got a show?

We want to know!
Have your photos
been published?

* Magazines
* Brochures

* Newspapers
* Scientific Journals
Send complete details to:
<bittled7 ) @gmail.com>
“If you don’t blow your own horn,
somebody else will use it

for a spittoon.”
Ambrose Bierce

Classified l

Classified Ads
Free to all
EPS members

BEST PRICES

in town
EPS WHOLESALE
print show supplies

$7 MATS (16”x 20” OD).
Double whites, acid-free
surfaces with stiff backers.
Center-cut with 10”x 15”
or 12”x 16” openings.
$14 WHITE MATS BLACK CORE
Available only with 10”x 15”
center-cut opening.

$17 FRAMES (16”x 20” OD).
Black or Silver aluminum,
with hardware & glass.

$5 TRANSPORT BOXES
for framed images.
(some assembly req.)

$2 from each mat, frame
or box purchase
goes to EPS.
Contact:
Bruce Bittle 541.343.2386
FREE Delivery to club meetings!

The Bellows is published ten times per
year by the Emerald Photographic Society, a
not-for-profit organization, and is completely
supported by EPS funds. All materials within
do not necessarily reflect the views of the
EPS Board of Directors, officers, membership,
supporting vendors or editor of this publication.
All brand and product names listed are
trademarked and/or registered and are not
necessarily endorsed by EPS. However, EPS

does endorse vendors, offering discounts to our
members, listed on the last page (randomly as
space allows on other pages) of each issue.
The Bellows policy is to always adequately
attribute all images & posted content. The Bellows
can not be responsible for images or any other
content acquired from unidentified web pages with
no visible attribution or on-line contact information.
Reprinting articles from The Bellows
for non-commercial use is permitted so long

as the photo or article is not copyrighted and
source credit is given to EPS, the author and
this newsletter. Any other reproduction requires
specific written permission from the editor.
Inquiries about, or submissions for
The Bellows (deadline is the last week of the
month for following month publication) send to
Editor, c/o Emerald Photographic Society, 1236
Debrick Rd., Eugene, OR 97401, or by email
<bittled70@gmail.com>
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EPS Preferred Vendors

Show your membership card to these vendors for nice discounts.
Be a good ambassador for EPS each time you receive these discounts
by letting these folks know how much you appreciate their support.

Dotson’s Camera Store
1668 South Willamette Street

15% Discounts on in-house processing (including slide processing)

camera’s home Focal Point Photograph
Yo‘%ay from home 161 West Ellendale, Dallas, gRy
Equipment Rentals, Trade Ins, discounts on most items Call Mike Lowery, 503.623.6300

Orelgon Galler
199 East Fifth Avenue, Eugene
15% discount on all matting and framing

Red River Paper

Professional quality papers of all types for much less than printer mfg. brands
10% rebate to EPS when ordered directly from our web site

eShutierling Camera Stores
Two Stores 207 Coburg Rd. & Valley River Center
10% discount on photo accessories and photo finishing

?ﬂq TechMedic| Apple Mac Computer Technicians
ﬂ EPS Preferred Vendor 2L 7“; 4?&335%% 0 3Y Center} ﬁ‘&

U of O Bookstore Art Department (Basement)
Corner of 13th Ave. & Alder St.
20% discount on all art supplies

Web Mats & Frames / Vistra Gallery
411 West 4th Street, Eugene
20% discount on printing, matting & framing, Up to 30% on orders over $500

N
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